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Adding Working Hours 
In order for CareFree to provide more accurate insights into capacity planning 

and allocate Carers more effectively it is helpful to add your Carers working 

hours to the database. 

Entering Carers working hours into CareFree will not prevent you from 

allocating calls outside of this time period. You will simply be warned that the 

call falls outside of the Carers working pattern. 

Completing this task will affect how accurate the recommendations are that 

are returned when filling unallocated calls. 

Specify a Working Pattern 
1. Open the Carers screen 

2. Select the Carer whose working hours you wish to 

add in the list on the left of the screen 

3. Click on the drop-down arrow next to the Rotas 

button 

4. Select Working Hours 

 

 

1 Select the Carer here 

2 Working hours are added here 

3 Use the arrows to skip through weeks 

1 

2 3 
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5. Right-click on the blank area where working hours are added (point 2 on 

the previous screenshot) 

6. Click Add New Time Period 

 

 

 

  

1 Enter start and end times for working periods here 

2 For Carers who work alternating shift patterns, specify how many 

weeks the cycle runs over  and then say which week(s) you are 

specifying for the working pattern for  

3 Choose a pre-set pattern for the days the Carer works here 

4 Either working, non-working, cover or office hours can be specified 
here 

5 Select the days to create your own pattern here 

1 

2 

3 

4 

5 
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Specify a One-Off Working Week 
A one-off working week may need to be entered when the Carers working 

pattern changes for a week or for a certain period of time.  

 

1. In the Working hours screen, click the One-off tab 

at the bottom of the screen 

 

2. Instead of seeing week 1, 2, 3 etc, at the bottom 

of the screen. Instead there is the option to select 

a specific week. Go to the week where the one-

off working time period needs to be entered 

3. Right-click on the blank area where working hours are added 

4. Click Add New Time Period 

5. The screen that appears is the same screen as described on page 6 

except there is no option to specify a week cycle as this is a one-off time 

period. It is important to note that you will need to plan the whole week 

of working hours if this option is used. 

 

6. Click Save and repeat on additional weeks if necessary 
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Advanced Rotas and 

Rostering 
In the first day of training we covered the basics in terms of building packages 

of care and adding calls to the Rota.  We will now look at the more advanced 

features and functions in relation to Rotas and rostering. 

Adding and Deleting Away Periods 
You would normally add an away period to the Rota when you have been 

made aware that a Client or Carer is going to be away i.e. Client is in respite or 

Carer is on holiday. 

• Away periods can be added to an individual call or for a specific block of 

time 

• Away periods always show blue if a Client is away and yellow if a Carer is 

away 

• The reason for the away period will be displayed at the top of the day(s) 

in which the away period(s) show 

Adding an Away Period to a Call 
This method of adding away periods is commonly used for when a Client has 

cancelled a call. 

1. Select the call on the Rota with a single left click 

2. Right-click on the Rota and click Away Periods 

3. In the sub-menu choose the most appropriate away reason 

 

 

 

 

 

 

The away reasons list can be amended in the items screen 
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An away period will then be added to the call on the Rota. 

 

Adding an Away Block for a Client or Carer 
An away block could be added to a Client or Carer Rota for a number of 

different reasons.  For example, Carer holiday, Carer sickness, Client in 

hospital, Client in respite etc. 

To Add an Away Block 
1. Go to the Rota for the Client or Carer where an away block needs adding 

2. Right-click on the Rota 

3. Click Away Periods 

4. Select the first option in the sub-menu which allows you to Add an away 

block between dates 
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To Add an Away Block continued… 

 

 

 

  

1 Specify a start and end date for the away period. If the end date is not 
known click the No End button 

2 Specific hours within a day can be chosen for the away period. 
Alternatively, the All Day button can be used which enters 00:00 – 
23:59 

3 When adding away periods for Carer holidays use this box to deduct 
the correct amount of annual leave hours or days from the Carer’s 
entitlement 

4 Specify the reason for the away period here  

5 To place a Client or Carer on Hold. Place a tick in the On Hold box  

6 Notes can be added to show on a Client or Carer Rota 

1 

2 

3 

4 

5 
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If a Carer is allocated to call when you add in an away period, you will be 

notified which calls will be affected.  It is possible to allocate the affected calls 

to a different Carer from within this notification window by clicking on the 

drop-down arrow next to the Carers name and selecting an alternative Carer 

from the list.   

 

If you do not wish to re-allocate the calls there and then they will automatically 

be added to the list in the unallocated calls screen.  

 

The away period will now display on the Rota.  

 

 

To learn more about the unallocated calls screen please refer to the CareFree Day 1 

Training Guide 
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Adding Repeating Away Blocks 
Repeating away blocks can be used for away periods which happen regularly 

on a Client or Carer Rota.  Possible scenarios for the use of repeating away 

blocks would be a regular day of respite care for a Client or a Carer who 

regularly attends college on a specific day of the week.   

1. Go to the Rota for the Client or Carer where an away block needs adding 

2. Right-click on the Rota 

3. Select Away Periods 

4. Select the first option in the sub-menu which allows you to Add an away 

block between dates 

 

 

 

1 Ensure the options to Add a repeat block for selected day between times is selected 

2 Ensure the date range covers the period during which the Client or Carer will be away 

3 Select an appropriate reason using this drop-down menu 

4 Choose which day/days the away period should be repeat on 

5 Select the frequency with which the away period repeats 

6 Click Save to save the away period 

1 

2 

3 

4 

5 

6 
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Deleting, Amending and Ending Away Periods 
The most straightforward way of deleting or ending away periods from a Client 

or Carer Rota is by using the Away Periods tab in the Rota screen.  

 

Use the away periods tab to access and amend away periods which have 

previously been added to the Rota. The tab also allows you to delete away 

periods which are no longer required.  

 

 

 

 

1 Select the month the away period is in  

2 Double click on an away period to open and amend details 

3 With an away period highlighted click the  icon to delete it 

1 

2 

3 
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Where an away period has been added to the Rota with no end date the away 

periods tab can be used to access the details and to specify an end date when 

the Client/ Carer returns. 

1. Go to the Rota 

2. Open the Away Periods tab 

3. Locate the away period and double click on it to view the details 

4. Enter the end date of the away period in the To Date field 

5. Uncheck the On hold option if the Carer/Client had been placed on 

temporary hold 

 

It is also possible to add away periods to Client or Carer Rotas from within the 

away periods tab.  Simply click on the  icon to begin adding a new away 

period. This is useful for when you need to add Carer holidays a long way in 

advance as the Rota screen only displays data for the next 13-week period. 
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Shadowing Calls 
Within the Rota screen you are able to allocate single or multiple calls to a 

Carer to shadow another Carer on their Rota. 

1. Open the Rota you wish to create shadowing calls on 

2. Either highlight one call or hold down the CTRL key on the keyboard and 

left-click on each call you wish to select 

3. A black outline will 

appear around the 

selected calls 

4. Right-click on the Rota 

5. Select Add and Delete 

Calls 

6. Click Make Shadowing Calls 

 

 

7. Select the Carer who will be shadowing 

on the selected calls 

8. Click OK 

 

 

 

 

9.   Shadowing calls for all selected calls will then be added to the selected 

Carers Rota 
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Adding Rotational Calls 
A Rotational call is one which occurs weekly but is covered by Carers who work 

in Rotation for example, Carer A covers week 1 Carer B covers week 2. 

It is possible to make only certain Carers available to cover calls in specific 

weeks.  Specify which Carers will work on each Rotation in the items screen. 

Setting Carer Rotations in the Items Screen 
 

1. Open the Items screen 

 

2. Select Carers and Weeks in the box at the top left of the screen 

 

 

  

1 Select Carers and Weeks from the items list 

2 Pick the Rotation week you would like to make Carers available for 

3 Enter edit mode and click    to select the Carers you want to make 
available in the selected Rotation week 

1 

2 

3 
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Adding a Rotational Call 
1. Go to the Rota of the Client you want to add a Rotational call to 

2. Right-click anywhere on the Rota 

3. Select Add and Delete Calls from the right-click menu 

4. Select Add New Calls 

 

 

 

 

Once created you can see at a glance which week of the Rotation a specific call 

relates to as it will show a number in the 

bottom right of the call box as shown to the 

right. 

1 Specify at least one need for the call 

2 Use the date field to specify the week that the call(s) will first appear on the Rota 

3 Select the Rotational pattern you need in the Type menu 

4 Complete all other call details as per the content covered in the CareFree Day 1 
Training Guide 

5 Choose the Carers who will cover the calls in the Rotation 

6 Different call times can be specified for each week of the Rotational pattern 

7 Select the appropriate working mode 

8 Click Save to add the call 

1 2 3 4 

5 6 

7 8 
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Rota Split Screen View 
The split screen view enables users to view the Rotas for both Clients and 

Carers simultaneously.  To open the split screen Rota view:  

1. Go to the View menu 

 

2. Select Rota Split Screen 

 

 

Carer Rotas are listed on the left of the screen and Client Rotas are listed to the 

right of the screen.  
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Set Rota Split Screen as the Default Rota View 
Users can opt to use the split screen as their default viewing mode for the 

Rota.  To change the default viewing mode:  

1. Go to the Tools menu 

2. Select Options and Settings 

and choose Personal Options 

3. Ensure General & Rostering is selected on the left of the screen 

4. Scroll down to the section Rostering and Rota Screen on the right of the 

screen 

5. Tick the option named Use the split screen as the default 

6. Click OK to save the changes 

 

Once saved the next time the Rota is opened the split screen will launch.  
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Allocating Calls in Split Screen View 
The split screen provides useful insight into Carer workloads and helps to 

identify suitable spaces in Rotas when users are attempting to allocate calls on 

Client Rotas.  Users can simply move down through the list of Carers until an 

appropriate space is identified.  Once an appropriate Carer has been found 

users can: 

1. Select the Carer who you wish to allocate the call to 

2. Select the call on the Client Rota 

3. Click the Allocate button 

 

 

  

1 Select a Carer on the left of the screen 

2 The selected Carers Rota has a suitable space for the unallocated call. Working 
hours are also shown on this screen. Refer to page 5 for more information on 
working hours 

3 Select a Client on the right of the screen 

4 Select the unallocated call to allocate to a Carer 

5 Select Allocate to allocate the selected Client call over to the selected Carer’s Rota 

1 

2 

3 4 

5 
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Site Types and Site Rota View 
You may wish to use this functionality if you provide care to Clients at external 

sites and locations e.g. care homes, day centres etc.  To begin using the Site 

Rota View, a list of alternative Sites and Site Types must first have been 

created within the Items screen: 

1. Open Items 

2. Go to Site Types in the list at the top left of the screen 

3. Click New to create a new site type and complete the details in the 

boxes 

 

Once the Site Types list has been updated, you can begin to store details for 

the Sites you require: 

1. Open Items 

2. Go to Sites in the list at the top left of the screen 

3. Select New to create a new site and complete the details in the boxes 

 

Add new sites to the appropriate site type category using the Type drop down 

menu. 
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Creating Site Calls on the Rota 
Once the list of sites has been populated, return to the Rota screen to begin 

categorising calls which take place at alternative locations. 

1. Either double click single calls, or highlight multiple calls, right click and 

select View Multiple Calls 

2. Select the site from the drop down menu 

 

Calls allocated to different sites can remain unallocated if the Site call must be 

allocated box is left unchecked.  

 

The option to leave site calls unallocated enables users to send multiple Clients 

to care homes/day centres for extended periods without having to allocate 

Carers to the calls.  A Carer could be allocated to just one of the Clients but in 

reality, could be providing care to a number of Clients at the same time.  

A tab has also been added to the Rota screen to enable users to view all Clients 

and calls for each site type and site. This can be found by:  

1. Opening the Rota 

2. Clicking on the Sites tab 
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24/7 – Live-in Functionality 
CareFree includes rostering functionality for organisations that deliver 24/7 

live-in care to Clients.  24/7 live-in care packages can be viewed within the 

planner screen once calls have been added to the Rota.   

A Client type of 24/7 live-in must be specified in the Client screen to enable 

users to create 24/7 live-in calls on a Client Rota.  
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Adding 24/7 Live-in Calls from the Rota 
1. Open the Rota 

2. Right-click on the Rota 

3. Select Add and delete calls then Add new calls 

 

 

 

  

1 Specify the start time and end time of the shift the Carer will do at the 
Clients home. 

2 Specify which days this shift needs to be added to 

3 Ensure This Week & Beyond is selected to ensure the calls are added 
to every week going forward 

1 

2 

3 

You may need to repeat this process if there are numerous shift changes through the 

day 

If the Carer stays at a Clients home for a number of days the start time must be set to 

00:00 and the end time set to 23:59 to ensure the block of time appears on the Rota 
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Adding 24/7 Live-in Calls from the Package Wizard 
 

1. Open the Client with 24/7 care 

2. Go to the Rota drop down button and click Packages 

 

 

 

 

3. Click the pen symbol  to the left to highlight the 

whole row, then right-click and select Every day 

 

4. Use the times to enter when Carers will be changing shifts. In the 

example below a Carer will be at the Clients home 8am – 8pm then 

another Carer will take over from 8pm – 8am 

If there are more shift changes than this example, add more rows in the 

package wizard 

 

5. Click Create once completed 

 

The package wizard is explained in greater detail in the Day 1 Training Guide – this 

section will explain how to add 24/7 Live-in calls through the package wizard 
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24/7 Live-in Planners Screen 
Once 24/7 Live-in calls have been created using the Rota, it is possible to view 

overall live-in packages in the planner screen.  To get the packages to display in 

the planner, you must first change specify which Clients you provide 24/7 live-

in care for. 

1. Open the Clients screen 

2. In the general tab change the Type drop-down box to 24/7 Live-in 

 

Once the Client types have been changed and the packages have been added, 

the 24/7 live-in planner will be available to view. 
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1. Open the Planners screen  

 

2. Select 24/7 Live-in using the drop-down menu at the top left of the 

screen 

 

 

 

 

 

3. Ensure the option to view Calls is selected in the drop-down menu at the 

bottom left of the screen 

4. Use the Refresh button at the bottom right of the screen to refresh the 

data 

 

The Planner screen is explained in more detail on page 47 of this training 

guide. 
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Capacity Planner Screen 
The Capacity Planner screen is available to assist with planning and helps 

decision making when considering whether or not a new Client/care package 

can be accommodated with current workloads. To open the Capacity Planner 

1. Go to the View menu 

2. Click Capacity Planner 

The classification of low, medium and high capacity can be changed by altering 

the values in the boxes at the top of the screen.  

 

Users can choose display the capacity planner based purely on the number of 

Carers not currently allocated to calls at a specific time or can opt to include 

Carer working hours if these have been specified within CareFree.  Select or 

de-select the working hours tick box to change the 

view.  
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More on the Unallocated Screen 
In addition to the standard view of the unallocated screen which we looked at 

during day 1 of our training, there are several extra views/screens which can 

provide further insights and assistance when attempting to cover unallocated 

calls. 

Advanced View 
The advanced view of the unallocated screen enables a coordinator to see how 

an unallocated call would fit into their Carers current Rota and provides access 

to the matching criteria data from the call allocation screen.   

1. Double click Unallocated in the status bar at the bottom of the screen 

 

2. Click on the Advanced tab 

 

 

  

1 Select a week and day to view unallocated calls for 

2 Click an unallocated call in the list to highlight it and begin looking for a suitable 
Carer 

3 The advanced view allows you to see CareFree’s matching criteria here 

4 Click on the advanced tab to open this view of unallocated calls 

5 The red call is the one you are trying to allocate. See how it fits into your Carers 
existing Rotas here 

6 When you have decided who will cover the call click the Carers name in the list 
then click Allocate 

1 

2 3 

4 5 

6 
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Ticked & Informed Tab 
This allows users to tick if the Client or family have been informed of a new 

Carer being allocated to a call.  It is also possible to override the original start 

time with an amended one.   

1. Double click on Unallocated in the status bar at the bottom of the 

screen 

2. Click on the Ticked & Informed tab 

 

 

3. Tick Client Informed and/or Family Informed if changes have been 

made to the call. This is recorded in the call details 
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Tracking Requests for Cover 
The unallocated screen also provides the option to tick which Carers have been 

contacted about covering a call from within the standard view tab. 

1. Open the Unallocated screen 

2. Click into the Carer column then use the drop-down arrow to track cover 

 

 

3. Use the tick boxes in the Called? column to mark off the Carers who 

have been contacted to request cover 
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Pencilling in Carers 
It is possible to pencil in Carers to cover calls from within the unallocated 

screen.  Once a Carer has been pencilled in, users will need to either confirm 

the allocation in the Rota screen, or select a different Carer using the 

unallocated screen.   

1. Open the Unallocated screen 

2. Locate the call you wish to pencil in a Carer for 

3. Click into the Pencilled in / Auto column, then use the drop-down arrow 

to select the Carer 

 

4. The same screen will appear, as it does when you are tracking cover for 

calls. This will not allocate the call to the Carer but will attach them to 

the call ready for confirmation 

 

Once a Carer has been pencilled in to a call, they are then confirmed from the 

Rota screen. 

1. Open the Rota screen 

2. Go to the Pencilled in tab 

 

3. Select the call you wish to confirm 

4. Click the Confirm button to confirm the allocation of the Carer 
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Auto Allocate Carers 
The auto allocation function will pencil in Carers for unallocated calls, based on 

the 9 matching criteria within the CareFree rostering system. When auto 

allocating, Carers are only pencilled in allowing users to check the suggestions 

made by CareFree and either accept or reject the recommended allocations.  

Open the Unallocated screen and select the Standard view tab 

 

 

 

 

To confirm the allocation of Carers who have been auto allocated follow the 

same process for confirming pencilled in Carers described in the previous 

section of this guide. 

  

1 Use the date controls to locate the calls you wish to auto allocate 

2 To select a single call to auto allocate click I the box to the left of the 
date. Use the CTRL button to select multiple calls 

3 Selected calls are highlighted in blue 

4 The suggested Carers will appear in the Pencilled In / Auto column 

5 Ensure the Standard view tab is selected 

6 Click the Auto button to auto allocate Carers to calls 

1 2 3 4 

5 6 
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Holidays 
Holiday Entitlements 
It is possible to specify whether holiday entitlements are calculated in hours or 

days within the CareFree options and settings.  

1. Go to the Tools menu 

2. Go to Options & Settings and select Shared Options in the submenu 

3. Select Employment & Holidays in the list on the left-hand side of the 

screen 

4. In the options for holidays select Show holiday as and set it to either 

days or hours using the drop-down menu 
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Deducting Holidays Taken from Entitlements 
There are two main ways in which holidays can be deducted from a Carers 

entitlement. 

Using the Carers Holidays Tab 
1. Open the Carers screen 

2. Go to the Carer who is taking holiday 

3. Click on the Holidays tab 

4. Click Edit 

5. Right-click in the white box 

6. Select New 
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7. Ensure the Holiday radio button is selected 

 

 
 

8. Fill in the details for the holiday, specifying the from and to date, the 

number of hours/days to be deducted in the Total Taken 

9. Using the Reason drop-down box choose ‘Holiday’ then click Save 

10.  The holiday will be deducted from the entitlement and an away period 

will be added to the Carers Rota 

 

Adding an Away Period on the Rota 
Use page 8 of this guide for best instructions on how to add an away period via 

the Rota.  Ensure that you add the following information when adding the 

away period. 

 

1. Using the Reason drop-down box choose ‘Holiday’ 

 

2. Deduct the correct number of hours/days of holiday from the Carers 

entitlement 
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Holiday Pay Calculator 
The holiday calculator enables users to see the average amount of hours or pay 

a Carer has earned over a specific time period. It can also be 

used to add pay as an adjustment to Carer wages based on 

the calculation it performs.   

Using the Holiday Pay Calculator 
1. Open the Tools menu and select Holiday Calculator 

 

 

 

 

2. Click Calculate to start the holiday pay calculation 

 

  

1 Select the relevant branch and Carer 

2 Select the date from which the calculation will be made 

3 Set the number of weeks to calculate average pay/hour over. The default is set to 
13 as this tends to be the most common working practice 

4 Tick the relevant call statuses to include into the calculation 

5 Tick Show pay not hours to show the average pay of each day/week, untick this 
box to show average hours of each day/week 

6 Tick Use actual times for pay to look at actual times rather than planned 

7 Tick Include holidays taken in this period to include annual leave that has been 
taken by the Carer in the date period selected 

8 Tick Exclude blank weeks (those without hours) to exclude any weeks within the 
selected date period where no hours have been worked by the Carer 

1 

2 

3 

4 

5 
6 

7 

8 

There must be some finalised wage sheets in the Carers records for the Holiday Pay 

Calculator to work out the calculation 
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The following calculation has been worked out with pay instead of hours. If the 

calculation is worked out with hours the principal is the same the calculation 

will show hours instead of currency. 

 

 

 

 

 

 

 

1 Each week included into the calculation is displayed here 

2 The calculation will work out how much the Carer has earned/worked on each day, 
which is displayed here 

3 The total number of hours/pay for that week is calculated at the end of the table 
showing how much the Carer has earned/worked  

4 The total number of hours/pay on each day of the week (Mon-Sun) are worked out 
to display the average pay/hours  

5 The totals of the week’s hours/pay are calculated to display the average pay/hours 
over the 12 weeks 

1 

2 

3 

4 

5 
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Adding Holiday Pay/Sick Pay to a Wage Sheet 
If the holiday pay calculator is being used for holiday pay and/or sick pay the 

following option can be used to add the pay to the Carers wage sheet. 

Click the Wages button to add an expense to the Carers wage 

sheet. 

 

 

 

1 Tick which days the Carer will not be working where they will be paid  

2 Use the Reason drop-down box to choose what expense reason will appear on the 
Carers wage sheet 

3 Use the Description free text box to enter any additional information in about this 
expense 

4 The amount will be calculated when you select a date. This will change depending 
on what option you set underneath 

5 Use the average from total line will use the average totals from each day. Looking 
back on the screenshot from page 38 at point 4 each average for Mon-Fri was 
added up giving a total of £54.42  

6 Daily average: weekly 102.62 / 7: This setting is working out what the Carer has 
earnt on a daily basis by taking the average weekly pay of 102.62 (calculated in the 
previous screen) then dividing this by the number of days worked (this number can 
be amended). In this example 102.62 / 7 is £14.66. As 5 days have been ticked the 
total would work out as £73.30 (£14.66 * 5) 

7 Daily average: weekly / days worked: This setting is similar to the previous option 
but the number of days worked out is worked out automatically 

8 Click Save to add the expense to the Carers wage sheet for the dates you have 
selected on point 1. The expenses will appear in additions and adjustments 

1 

2 

3 

4 

5 

6 

7 

8 
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Linking to Documents, 

Policies & Procedures 
CareFree provides the option to link to your organisations guidance 

documents, procedures or policies in various places throughout the database.  

These links are designed to assist employees when dealing with issues which 

require a set process to be followed. 

For example, if a complaint is received which needs recording as a log entry in 

a Client record. It is possible, to create a quick link to your complaints 

procedure document to provide appropriate guidance for the co-ordinator 

creating the log.  Once the link has been created the co-ordinator can click the 

 icon in the log entry screen to access the complaints procedure document. 

 

The process of creating links to documents, policies and procedures involves 

two stages: 

• Specifying document types 

• Configuring the links 
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Specifying Document Types 
First you must specify what type of documents you wish to add into CareFree. 

You can create document types via the Items screen: 

1. Open the Items screen 

2. Go to the Document types list 

3. Click New to add or edit to update the list of document types. Think 

what documents you would like to provide quick access to throughout 

the system. Press Ok to save any changes 
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Configuring the Links 
With the Document types created in the Items screen, it is possible to specify 

the way the links will work within CareFree.  To do this: 

1. Go to the Personnel menu and click Documents & Policies 

2. You will be presented with a list of your document types 

 

3. Right click on the screen and select New to begin creating your links 

using the document item window 

 

 

 

 

1 Click on the magnifying glass to browse your computer network and 
find the document you wish to create a link to 

2 Select the Document Type  

3 Give the document an appropriate name and/or description 

4 Select which area of CareFree this document will be linked to. Select 
either QA or the Contact Log drop down 

5 Click Save to add to the document and create the link 

1 

2 

3 

4 

5 

By adding a document from a shared drive this will allow all other users/machines who 

have access to the shared drive to have access to this document. If the document is 

attached locally only that machine and user will be able to access the document 
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Workflow 
Workflows in CareFree are fully customisable checklists which can be used to 

easily track processes with defined stages. The stages must be signed off or 

completed, for the overall process to reach a conclusion.  Workflows are often 

created in CareFree for processes such as:  

• Tracking the recruitment of Carers 

• Tracking Client referrals 

• Following a formal complaints procedure 

• Carer inductions 

There are 3 steps involved in creating and using workflows: 

• Creating a workflow 

• Attaching the workflow to a Client or Carer 

• Tracking workflow progress 

 

Creating a Workflow 
To create a workflow, you will need to give it a name and specify the stages 

which will make up the process as a whole: 

 

1. Go to the Personnel menu and select 

Workflows 

 

2. Ensure the Edit Workflow radio button is selected and click New 
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3. Give the workflow an appropriate name 

4. Tick Automatically add to new 

Carers for the workflow to 

attach to new Carer records 

automatically 

5. Click Save 

 

6. The radio button will move from Edit Workflow to Stages as soon as the 

new workflow is created  

 

7. Click New to add the first stage to the workflow  

8. Complete the details for the workflow stage 

 

 

 

9. Repeat this process for all stages of the workflow until completed 

 

 

1 Give the stage an appropriate Description 

2 Specify the number of Days the stage should be completed in from the start date of the 
workflow before it is classified as overdue 

3 If the stage isn’t a mandatory part of the overall workflow choose Yes in the Optional 
drop-down menu 

4 Users can send mail merge letters to recipients as each stage of a workflow is completed. 
To set up mail merge, choose the contact type you would like to send the letter to in the 
Source drop-down box and select the letter template in the Letter drop-down box 

5 Click Save 

1 

2 

3 

4 

5 

Change the stage number when adding a new stage to re-order stages if a stage has 

been missed 
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Attaching Workflows to a Client or Carer 
 

1. Open the Clients or Carers screen 

2. Go to Workflow in the Rotas Drop Down Menu  

 

 

3. Use the lists on the left-hand side of the screen to go to the Client or 

Carer you wish to attach the workflow to 

 

 

4. Click New 

5. Use the drop-down box 

Workflow type to choose the 

workflow you want to attach 

the Carer/Client 

 

6. Select the Start Date for the workflow, if there is no start date tick No 

Start Date 

7. Click Save to attach the workflow to the Carer/Client 
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Tracking Workflow Progress 
Once a workflow has been attached to a Carer or Client, it will be visible within 

the workflow screen.   

 

It is possible to complete stages within the workflow and track progress using 

the workflow screen. 

1. Open the Clients or Carers screen 

2. Navigate to workflow in the Rotas drop down menu 

3. Locate the Client or Carer who is engaged in the workflow 

4. Double click on the stage of the workflow you wish to complete 

 

 

 

 

 

 

A more user-friendly way of tracking Workflow progress is available within the 

Planner screen in CareFree and this will be explained on page 49 of this 

training guide. 

1 Enter the date the stage was completed 

2 Add any notes then click Save 

1 

2 
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Planners Screen 
The Planners screen in CareFree provides an overview of current business 

activity and enables users to identify peaks and troughs in resource allocation.  

There are four different planners within CareFree and we will look at each in 

turn.    

 

1. To open the Planners screen, click on the Planners icon  

2. To select a planner to view, use the drop-down menu in the top left 

corner of the screen 

 

 

How the Planner Can Be Used 
There are a variety of ways the Planner can be useful to co-ordinators.  A 

number of examples are listed below: 

• Overlay the calls and working hours Planners to identify appropriate 

gaps in Carer working patterns when trying to accommodate/allocate 

new Clients/care packages 

• Use the QA Planner to keep a track of planned training and assessments 

on a weekly/monthly basis 

• Overlay QA and call planners to ensure there are no conflicts 

• Use the away planner and filter by away reason to view Carer sickness 

patterns or view holidays booked 
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Planner 
The main CareFree Planner provides a calendar style overview of activities 

relating to both Clients and Carers.  Data can be filtered according to a variety 

of criteria.  

 

 

 

1 Select the Planner view in the drop-down 

2 Filter data by company and branch 

3 Select to view the data from the home branch only 

4 Show legends displays a description against data on the Planner  

5 Planner data is displayed here 

6 A single click on any of the planner blocks will reveal further detail. Double clicking on 
away periods, QA schedules, and calls will open full detail windows 

7 Select to display data for Client or Carers 

8 Use the drop-down menu to select the time period you wish to view data for 

9 Use the second drop-down menu to choose the data to display in the Planner (QA, calls, 
away periods, working hours) 

10 If an away period is selected use the Away Options drop-down menu to select which away 
periods you wish to view 

11 If a QA is selected use the QA Options drop-down menu to select which QA’s you wish you 
view 

12 Select the date you wish to view data for 

13 Click Refresh to update the Planner screen after changing options 

1 
2 3 4 

5 

6 

7 

8 

9 10 11 12 13 
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Workflow Planner 
As mentioned in the previous section on workflow, the workflow Planner 

presents a more user-friendly way of tracking workflow progress in CareFree.   

 

1. Click on the Planners icon  

2. Select Workflow using the drop-down menu in the top left corner of the 

screen 

 

3. Use the Workflow Planner to complete stages within a workflow for 

Carers and Clients 

4. Double click on the stage you wish to complete and enter a completion 

date 

 

 

  

1 List of Clients or Carers who are engaged in the workflow 

2 Choose to view workflows for Clients or Carers 

3 Select the workflow type you wish to view data for 

4 White indicates a stage is complete or it hasn’t reached its due date 

5 Red indicates a stage is overdue 

6 Double-click on a stage to enter a completion date 

7 Workflow stages are listed across the top of the screen 

8 Use the Refresh button to refresh data on the screen 

1 

2 

3 

4 5 6 7 

8 
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Efficiency Planner 
The efficiency planner shows the percentage of hours a Carer has been 

allocated compared to their available hours.   

 

1. Click on the Planners icon  

2. Select Efficiency using the drop-down menu in the top left corner of the 

screen 

 

 

 

  

1 Carers are displayed to the left of the screen 

2 Use the drop-down menu to choose either Working Hours or Start-
Finish.  
The Working Hours option will look at the Carers efficiency based on 
what working hours have been entered against what calls have been 
allocated to the Carer. 
The Start-Finish option will look at the Carers efficiency based on their 
shift (the allocations of calls between their first call and their last call)  

3 The percentage of efficiency is displayed at the end of each Carers row 
here 

4 A green bar will indicate the Carers efficiency visually 

5 Select the date you wish to view data for 

6 Click Refresh to update the Planner screen  

1 
3 

2 

4 5 6 
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Preferences and Options 
It is possible to change both personal user options and shared system options 

within CareFree. 

• Settings changed can be reversed 

• Be aware whether the change you are making affects you, or all users of 

the system 

 

Accessing Options & Settings 
1. Open the Tools menu 

2. Go to Options & Settings 

3. Select the required option from Personal Options or Shared Options 
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Commonly Used Options & Settings 
Below is a list of the most commonly amended settings within the system. 

Reports Toolbar 
This option allows you to store your most commonly used reports at the 

bottom of every screen for ease of access.  To use the reports toolbar, it must 

first be activated. To activate the toolbar. 

1. Open the Tools menu 

2. Go to Options & Settings 

3. Select Personal Options 

4. Place a tick in the box next to Show reports toolbar which can be found 

under General Options 

5. Click Apply to save changes 

 

6. Once activated you will see the report toolbar displayed at the bottom 

of your screen 

 

Create a Link to a Frequently Used Report 
1. Open the Reports screen  

2. Select the appropriate report group in the box at the top left of the 

screen 

3. Click and drag the name of the report down onto the report toolbar 

 

 

4. To remove the report right-click Report Menu and remove the report in 

question  
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Showing Mobile Numbers on Lists 
This option will show your Carer mobile numbers on the list of Carers in 

CareFree and on the Rota.  

1. Open the Tools menu 

2. Go to Options & Settings 

3. Select Personal Options 

4. Select People in the list on the left-hand side of the screen 

 

5. Place a tick in the box next to Show mobile number on lists which can 

be found in Carer Options 

6. Click Apply to save the changes 

7. There is also an option to Show home number on lists in the Client 

Options on this screen 
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Allow Dragging and Dropping of Calls 
This option allows users to turn on and off the drag and drop function when 

working in the Rota screen.  Whilst drag and drop can be useful, some 

organisations prefer to limit access to the functionality to reduce the chance of 

errors occurring.   

1. Open the Tools menu 

2. Navigate to Options & Settings 

3. Select Personal Options 

4. Select General & Rostering in the list on the left-hand side of the screen 

5. Scroll down to the options for the Rostering and Rota Screen 

6. Either tick or untick the option to Allow dragging and dropping of calls 

7. Click Apply to save the changes 
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Red Borders for This Week and Beyond 
This option helps to highlight when users are making changes which affect the 

whole care package by selecting This Week & Beyond in the Rota screen.   

1. Open the Tools menu 

2. Navigate to Options & Settings 

3. Select Personal Options 

4. Select General & Rostering in the list on the left-hand side of the screen 

5. Scroll down to the options for the Rostering and Rota Screen 

6. Either tick or untick the option to Red borders for this week & beyond 

7. Click Apply to save the changes 
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Rostering Warnings 
There are numerous warnings which can be triggered in CareFree to warn 

users where allocating a Call to a particular Carer, which may result in a 

conflict, or would contravene preferences which had been set for the 

Client/Carer.  To access and change these Rostering Warnings: 

1. Open the Tools menu 

2. Navigate to Options & Settings 

3. Select Shared Options 

4. Select Rostering in the list on the left-hand side of the screen 

5. Select which warnings you would like to activate in the Warnings box 

6. Click Apply to save the changes 

 

 

 

 

 

 

  

Please note that these are global (shared) settings so any changes you make will affect 

other CareFree users in your organisation 



 

 

57 

Verification 
Using CareFree to help manage the delivery of care to your Clients should 

follow a step by step process from using the Rota to planning your care calls, 

through to invoicing your Clients and paying your Carers.  The verify screen fits 

in between these two processes and provides a simple interface for managing 

what is actually happening out in the field as your Carers visit your Clients. 

 

 

 

 

 

Using the Verify Screen 
The Verify screen is used to manage any situation where what was planned on 

the Rota is not what was actually delivered by the Carer out in the field.   

Variations from what was originally planned through to what was actually 

delivered can occur for a variety of reasons and it is important to ensure that 

the Verify screen is used to ensure that the correct data is fed through into the 

pay and charge rules to generate accurate invoices and wages.   

The way in which the verify screen works varies depending upon whether your 

organisation is using Electronic Call Monitoring (ECM) or if you manually 

monitor care delivery.  

To view the Verification screen. Press  from the top of the screen in 

CareFree. 

  

The Rota is what we use to 

plan the delivery of care for 

our Clients 

Verify is where we manage 

exceptions and make 

adjustments for what has 

happened out in the field 

All this data is fed into the 

pay and charge rules to 

help produce invoices and 

wages in reports 
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It is possible to view more than two weeks ahead in the Verify screen.  A 

column is also available to view the screen which shows Clients Phone 

Problems.  

 To view this column: 

• Click on the Verify icon to open the Verify screen  

• Right-click in the verify screen 

• Select Show Phone Problems 

 

 

1 Use the date control to navigate to the week of the calls you wish to 
verify 

2 Use filter buttons to include/exclude call where planned & actual times 
exceeded specific parameters 

3 Use the filter buttons to either include or exclude data for specific days 
of the week 

4 Use the filter buttons to include/exclude calls with specific call statuses 

5 Users can choose to view verify data by Carer, Client or for individual 
days of the week 

6 Double-click on an individual call to view more detailed information 

7 Click Refresh to update the screen when parameters have been 
changed 

1 2 3 4 

5 6 7 
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Call Status 

The status of a call in the Verify screen will determine what information is fed 

into Invoicing and Wages.  A brief description of each call status is provided 

below: 

Call Completed 

•  

• The call has been completed as planned on the Rota 

• For organisations who don’t use ECM, we recommend setting the 

default status of all calls to Completed when creating Contracts 

• For organisation who use ECM, the status of a call will change to 

completed if a Carer logs in and out at the call within set tolerances of 

the planned start and end time  

• Completed calls will be picked up for both Invoicing and Wages 

Missed Call 

•  

• The call has not taken place as planned on the Rota 

• For organisations who don’t use ECM, a coordinator may need to go into 

Verify and apply Missed as an override status to a call if a Carer failed to 

complete a call 

• For organisations who use ECM, a call will register as Missed in the 

Verify screen if a Carer does not log into a call within a set tolerance 

period on the planned start time on the Rota 

o Alerts can be triggered for coordinators in CareFree when calls are 

missed 

o If a Carer has simply forgotten to log in/out at a call, a coordinator 

can apply an override status of Completed 
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No Call Required 

•  

• The call has been cancelled on the Rota and a Carer is no longer required 

to attend 

• The call will have been cancelled by a coordinator adding an Away 

Period to the Clients Rota 

o Adding Away Periods to specific calls, or adding Away Blocks 

between dates will result in calls appearing with the status NCR in 

Verify 

• NCR calls will not be picked up for Invoicing & Wages 

o It is necessary to apply an override status to an NCR call if a Client 

has cancelled their call without providing sufficient notice and you 

wish to charge them for the call, and/or pay the Carer 

Invoice Only 

•  

• Calls marked as Invoice Only will not be picked up in Carer Wages runs, 

but will appear in Invoicing for Clients 

Wages Only 

•  

• Calls marked as Wages Only will not be picked up in Client Invoice runs, 

but will appear in Wages for Carers 

Aborted, Penalty & Cancelled Calls 

•  

• Aborted, Penalty and Cancelled are all call statuses which can be tailored 

by users to feed specific data into Invoicing and Wages. This will depend 

on the business rules, terms and conditions your organisation has 

adopted 

• The method for changing the rules behind Aborted, Penalty and 

Cancelled Calls is covered in detail at the end of this section 
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Unexpected Call 

•  

• An Unexpected call will be generated in Verify when a call which has not 

been planned on the Rota occurs 

• Unexpected calls are only generated when ECM is in use 

• A common reason for an Unexpected call appearing is where Carers 

agree to swap calls without notifying the coordinator 

o In this situation, the original (planned) call will register as Missed 

in Verify and the call completed by the wrong Carer will appear 

with the status set to Unexpected 

o It is possible to match up and fix these calls in the Verify screen 
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Call Status & Override Status 
All calls will be assigned a status in the Verify screen.  For organisations with 

ECM, the default status of all calls should be call waiting until a call is either 

completed or missed by a Carer logging in and out within a specific time 

period.  For organisations without ECM, the default status of calls is set when 

creating contracts (this is explained in our Day 1 Training guide). 

It is possible to apply an override status to any call in the verify screen, when 

the assigned status is incorrect or will feed inaccurate information into Invoices 

and Wages.  The most common reasons for applying an override status are: 

• Carers forgetting to log in/out of calls where ECM is used, resulting in 

completed calls registering as missed 

• Calls which are cancelled by Clients which still require some level of 

charge/payment to be levied 

 

 

 

 

 

 

 

 

 

 

 

  

All calls will be assigned a status in the verify screen. 

This will appear in the S column 

An override status can be applied to calls, in 

situations where the assigned status will not feed 

the necessary information into Invoicing & Wages. 

If an override status is applied, it will appear in the 

O column. 

Once the verification process has been completed, 

calls can be locked to prevent further changes. If a 

call is locked, a padlock will appear in the L column 
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Applying an Override Status to a Single Call 
There are several methods which can be used to apply an override status to a 

call: 

1. Double-click on the call in the Verify 

screen 

2. Select the override status using the 

drop-down menu 

3. Click Save 

Or  

Double-click in the override status column on the call to cycle through the 

override statuses until you reach the one you require 

Or  

1. Select the call in the Verify screen 

2. Right click and select Set Call Status 

3. Select the override status required in 

the sub-menu 

 

Applying an Override Status to Multiple Calls 
It is possible to quickly apply the same override status to a batch of calls: 

1. Select the first call and hold down the CTRL key on the keyboard 

2. Select the other calls by left clicking on them. The selected calls will turn 

grey 

 

3. Right-click and select Set Call Status 

4. Choose the override status required in the sub-menu 
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Changing Call Details Using Verify 
A range of information relating to a call can be changed from within the Verify 

screen:  

 

 

 

 

 

 

 

 

 

 

 

 

 

  

1 Actual Times will automatically be populated when the Carer logs in 
and out of the call if the organisation use ECM. These times can be 
completed/edited by a coordinator if required 

2 Change the Drive status of the Carer here for mileage payments 

3 Needs and Expenses can be edited/added to call from within the 
Verify screen if required 

4 A Variation Reason can be added to explain why changes have been 
made to call details in the Verify screen. A variation reason list can be 
amended in the Items screen 

1 

2 

3 

4 
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Setting Options for Aborted, Penalty & Cancelled Calls 
By default, Aborted, Penalty & Cancelled Calls will not be picked up in Invoicing 

and Wages. The statuses were created to give organisations sufficient flexibility 

to accommodate unique cancellation terms and business rules.  To alter the 

rules for Aborted, Penalty & Cancelled Calls: 

1. Open the Tools menu 

2. Navigate to Options & Settings and select Shared Options 

3. To set the rules governing Customer charges select Invoices in the list on 

the left 

4. To set the rules governing Carer wages, select Wages in the list on the 

left 

 

 

 

  

1 Select Invoices or Wages in the list on the left 

2 Rules behind Aborted, Penalty and Cancelled calls can be specified 
here 

1 

2 
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Aborted, Penalty and Cancelled Call Setup Scenario 
For demonstration purposes, our scenario presumes the following business 

rules exist: 

• If a call is cancelled with less than 24 hours’ notice, the Client will be 

charged and the Carer will be paid 100% of their costs /wages 

• If a call is cancelled with less than 48 hours’ notice, the Client will be 

charged and the Carer will be paid 50% of their costs/wages 

• If a call is cancelled with more than 48 hours’ notice, there will be no 

charges or payments to Clients/Carers 

In this scenario, it is important to remember that regardless of how much 

notice is given, all cancelled calls will appear in Verify with the status NCR (No 

Call Required). This happens once the coordinator has cancelled them using an 

Away Period on the Client Rota.  As NCR calls are not picked up for Invoicing 

and Wages, we will need to change the status of the calls where a Client gave 

less than 24 hours’, or 48 hours’ notice to ensure that the correct charge and 

pay information is fed through into Invoicing and Wages.  To do this we would 

recommend the following: 

1. Open the Tools menu 

2. Go to Options & Settings and select Shared Options 

3. Select Invoices in the list on the left 

4. Change the Penalty Calls value to 100 and change the Penalty Option 

from Minutes to Percent 

5. Change the Cancelled Calls value to 50 and change the Penalty Option 

from Minutes to Percent 

6. Then select Wages in the list on the left and make the same changes 

We can now use the call Override Status Penalty on any NCR calls in verify 

where a Client gave less than 24 hours’ notice, and can use the Cancelled 

status where a Client gave less than 48 hours’ notice.  
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Using Away Reasons to Cancel Calls 
It often helps to pick up the cancelled calls which need an override status 

applying in the Verify screen if appropriate away reasons have been added in 

the Items screen.  In our example scenario, a coordinator may wish to have 3 

away reasons for when a Client cancels a call: 

• Client Cancelled 

• Client Cancelled 24hr 

• Client Cancelled 48hr 

To add or edit away reasons: 

1. Open the Items screen 

2. Go to the Away Reasons list in the box at the top left 

3. Click New to add new items to the list 

Away Reasons can be displayed in the verify screen to allow coordinators to 

quickly identify the calls which need an override status applying. 
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Using QA 
QA is used in CareFree to schedule events such as training courses, 

assessments, spot checks and meetings etc for both Clients and Carers.  It is 

possible to display QA’s which have been scheduled on a Client or Carers Rota 

and QA events can be configured so that they automatically re-schedule 

refresher events after the appropriate time period has elapsed. 

 

Creating & Editing QA Types in the Items Screen 
Before creating schedules for your Carers or Clients, we recommend spending 

some time updating the information relating to QA in the Items screen. 

The QA types list contains all the training courses and assessment types you 

might wish to schedule for your Carers and Clients.  You may wish to create QA 

Types to schedule regular checks of Carer driving licences/insurance details, or 

to plan regular staff meetings.   

1. Open the Items screen  

 

2. Go to QA Types in the box at the top left 

of the screen  
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1 Select QA Types from the Items list 

2 Select a QA type and click Edit to amend its properties. If the QA type 
that is required is not there click New 

3 Choose an appropriate Name for the QA type 

4 Can the QA type be scheduled for Carers or Clients or both groups? 

5 Category and Code relate to NMDS data uploads 

6 Specify how often the QA type needs to be scheduled for by entering a 
number in Clients or Carer. Then select weeks or months in the 
interventions drop down box 

7 Specify how close to the schedule date you want a QA warning to 
appear. This warning appears at the bottom of the 
CareFree menu when the QA is due  

8 Tick Add to new people if this QA needs to be added to new 
Clients/Carers. Type in how many days after their start date that the 
QA would be need to be scheduled in for  

9 Use this box to link the QA type to a qualification. The qualifications 
list can be configured in the Items list 

1 

2 

3 
4 5 

6 

7 

8 

9 
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Linking QA to Qualifications 
It is possible to link QA Types with Qualifications. Once this link has been 

made, the Qualifications tab in the Carer screen will automatically be updated 

when QA schedules are completed for Carers.  Before linking QA Types to 

Qualifications, you may wish to update the Qualifications list in the Items 

screen. 

Scheduling QA for Carers & Clients 
 

1. Open the QA screen by clicking on the QA icon  

 

 

 

  

1 Select an individual Carer or Client to display their QA schedule 

2 Use the tabs to display QA for either Carers or Clients 

3 Scheduled, completed and missed QA items for each Carer and Client 
are displayed here 

4 Filter the list to display on specific QA types here. Use buttons to 
show/hide QA by status  

5 Use the New button to create a new QA schedule. Use the Edit or 
double-click on a QA to amend an existing QA schedule 

1 

2 
3 

4 
5 
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1. Click New to create a new QA schedule 

 

 

  

1 Select the QA type you wish to schedule 

2 Select the month and year for the QA schedule 

3 Place a tick next to Scheduled On to specify the date the QA will occur. 
If the exact date is not yet known the system will default to the 1st of 
the month 

4 Use the Location field to manually input a location or pre-populate the 
Venue list in the items screen to pick frequently used venues and allow 
mileage calculations 

5 Populate the items list for Learning Types (e.g. e-learning, classroom) 
and Satisfaction Scores (the score would be given by the attendee) 

6 To assign another Carer as the trainer or assessor for the QA, pick their 
name in the drop-down list here. The QA will also then appear on their 
Rota 

7 Add Planned Times and add a tick to Show On Rota to make the QA 
appear on the Rota (keep spot checks hidden!) 

8 Click New Log to create a log against the QA 

9 Click Save to schedule the QA item 

1 

2 
3 

4 

5 
6 

7 

8 
9 
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Completing Scheduled QA Items 
Once an assessment or training course has been completed, it is important to 

ensure that the QA schedule is updated.   

To complete a scheduled QA item: 

1. Open the QA Screen by clicking on the QA icon 

2. Go to the Carer or Client who has completed the QA 

3. Double-click on the QA schedule that requires completion 

 

 

4. If you are completing a QA schedule which has been created with a 

specific intervention period in the Items screen, the following warning 

when will appearing when saving the QA 

5. Click Yes if you would like CareFree to add a new schedule for when the 

QA is next due to be repeated 

 

1 Place a tick in Completed On and specify the date on which the QA 
was actually completed 

2 Add the name of the person who is signing off the QA in By Whom 

3 Responded On is a space to log an additional date if tracking is 
required i.e. sending certificates 

1 

3 

2 
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Copying QA Schedules to Multiple Carers 
It is possible to copy the same QA schedule to multiple Carers.  This is useful 

when arranging a training course or a meeting which several Carers will attend 

at the same time.   

1. Open the QA Screen  

2. Create the QA schedule for one Carer by following the steps listed on 

page 71 

3. Click on the Tools button 

 

 

 

 

  

1 Choose to copy the schedules from either Carers or Clients 

2 Use the drop-down menu to locate the Carer/Client for whom the QA 
was scheduled 

3 Place a tick next to the QA schedule you wish to copy 

4 Tick the Carers/Clients that require a copy of the QA schedule to. The 
two boxes at the bottom of this list are used to tick or untick 
all Carers/Clients   

5 Click OK to copy 

1 

3 

2 

4 

5 
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Reports 
The Reports screen is where you would go in CareFree to get specific data out 

of the database.   

The Reports Screen 
The Reports screen always works in the same way, regardless of the type of 

Report you wish to output.  Once you have mastered running an individual 

Report, you will be able to apply your knowledge to use all the Reports within 

the database.  To open the Reports screen: 

1. Click on the Reports icon  

 

 
 

1 Select which group of reports to view using this box 

2 There will be multiple reports available within each group – choose the most 
appropriate report 

3 Specify a date range using the Choose the dates tab (if applicable) 

4 Select people or groups of people to include using the Select from the list tab 

5 Use the other tabs to select options and specify parameters which can vary 
depending on which report is being ran 

6 Use these drop-down boxes to specify further options, choose reports formats and 
place filters on data 

7 Financial reports will need to be calculated before they can be previewed 

8 Click Preview to view the report. Use the drop-down menu to see the 
Print/Email/Export options 

1 

2 

3 4 5 

6 7 8 
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Using Reports to Generate Carer Rotas 
One of the most common reasons to access the Reports screen is to output 

Carer Rotas.  The Rotas can either be printed in hardcopy, or emailed directly 

to Carers if email addresses and email server details have been stored within 

CareFree.   

 

 

1. Open the Reports screen 

2. Select the Service Delivery group of reports in 

the box at the top left 

3. Select the Rotas and Timesheets report in the 

box below 

 

 

 

4. Ensure the report is set to print for Carers with the status set to Active in 

the two drop down menus at the bottom of the report 

 

5. Use the Choose the dates tab to specify the date range for the Rota 

a. Use the pre-set date ranges or use the 

Custom option to specify the date 

range for complete flexibility 

b. Choose which day of the week your 

Rota starts on using the Week starts 

on drop down menu 

c. Use the Time range boxes to specify start 

and end times for the Rota period  
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6. Use the Select from List tab to choose the Carers for whom you wish to 

output the Rota to 

7. You can leave all Carers selected, de-select all or pick individuals from 

the list 

 

 

 

 

8. Use the Status tab to decide which 

call statuses to include on the Carers 

Rota 

a. This allows a decision to include 

NCR calls on a Rota – showing 

the Carer that a call has been 

cancelled 

 

9. Use the Branches tab to 

include/exclude specific branches 

when outputting the data 

a. By de-selecting some 

branches, the list of Carers in 

the select from list tabs will be 

altered accordingly 

 

Use the top drop-down menu to select a different 

format for the Rota – to gain access to other formats go 

to the Reports Setup. See page 78 for more information 

Use the second drop-down menu to filter 

the list of Carers to show only the people 

with email addresses stored in the database. 

This is useful when some Carers accept email 

Rotas and some require a hardcopy 

Use these buttons to tick or untick all Carers 
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10.   After the relevant selections have been made, click the Preview button 

to view the Rotas on screen 

11.   The report preview screen will open showing the Rota for the first 

Carer you selected in the list 

12.   Use the arrow buttons to click through the preview for your other 

Carers 

 

 

 

 

 

 

 

 

  

Click on the toggle group tree 

button to access a list of the 

previews on the left-hand side 

of the screen 

Use this drop-down box to magnify the 

report for better viewing. By selecting Page 

Width the preview will be easier to read 

Click on a Carers name in the list to 

quickly jump to their Rota preview 
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Gain Access to more Report Formats using Reports 

Setup 
Over many years we have created hundreds of bespoke report formats for our 

Clients in response to their specific organisational requirements.  It is possible 

to browse through the formats we have created to see if any of our existing 

Rota/Invoice/Wage Sheet/Care Plan/Risk Assessments would suit the needs of 

your organisation.   

 

1. Open the Tools menu 

2. Click Reports Setup 

 

 

3. Once you have selected some new formats and clicked OK to save, close 

the reports screen and re-open to refresh the formats drop-down menu 

4. Go back and try running your Rotas using a different format, using the 

drop-down menu in the Select from List tab 

 

Select the 

Report Type 

using this drop-

down menu 

Use buttons to 

select all format 

in the library 

Click OK to save 
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Useful Reports in CareFree 
There are over 300 different reports within CareFree.  Once you have practiced 

generating Rotas in reports, it is best practice to access some of the other 

reports within the database.  The reports module is extremely flexible and you 

should be able to find information relating to virtually any aspect of your 

business within the system.  Listed below are some useful reports with brief 

descriptions and guidance on locating them. 

 

Report Group Report Name Report Descriptionscoo 

Service Delivery Full Weekly Rota Shows all calls for all Clients and Carers for 
a full week, grouped by day 

On Call Report Report intended to be used by on-call 
organisers who don’t have access to 
CareFree at nights/weekends 

Verification Hardcopy of the verification screen 
showing full list of calls with statuses 

Clients Birthday List Quick list of all Clients who have a birthday 
in the near future – can specify how many 
months in advance the report will show 
(also available for Carers) 

Contact Logs List of all contact logs for all Clients.  
Report can be filtered by contact log type 
and grouped by Client name or log type 
(also available for Carers) 

Keysafe Numbers All keysafe numbers for all Clients 

QA Schedules All planned and completed QA items for all 
Clients (also available for Carers)  

Invoices Create & Finalise Invoices Calculate, preview and then finalise 
Invoices 

Wages  Create & Finalise Wages Calculate, preview and then finalise Wages 

Business Forecast Spend & Revenue One-page summary showing total care 
hours and net profit.  You can enter 
prospective hours to see the effect on cash 
flow 

Profit & Loss Compares calculated or finalised Invoice 
values with wages to give indicative 
profit/loss figure 

Electronic Monitoring Planned & Actual Times Simple comparison by Client, Carer or date 
showing planned against actual care time 
delivered 

Analysis & Statistics Client Statistics  Shows the number of Carers, Clients and 
care hours now compared with 12 months 
ago highlighting % increase/decrease 

CQC & RQIA AQAA Dataset Shows some numerical data relevant to 
the AQAA dataset 

Continuity of Care Compliance report showing each Client 
with the number of Carers allowed against 
the number actually used 

People Statistics  Statistical report showing people with age, 
gender, ethnicity and start date 
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CareFree Mail Merges 
CareFree has the ability to export a mail merge template, with that template 

you can then create letters via Microsoft Office or some other compatible 

desktop publishing application. In this example we will be using Microsoft 

Office Word. 

Once the letter has been created with the correct merge fields, its then 

possible to import that letter back into CareFree and use the system to create 

the letters for printing or emailing.  

 

1. Go to Letters from the top menu bar in CareFree 

2. To export a merge template, change the Source drop down box to 

export Clients, Carers, Staff etc. 

 

3. When the correct source has been selected tick all sources on the left of 

the screen 

 

 

4. Use the                 boxes to either tick all or un-tick all items 

http://knowledge.homecaresoftware.co.uk/lib/exe/fetch.php?cache=&media=2018-08-08_11h24_57.png
http://knowledge.homecaresoftware.co.uk/lib/exe/fetch.php?cache=&media=wiki:2018-08-08_11h21_58.png
http://knowledge.homecaresoftware.co.uk/lib/exe/detail.php?id=letters&media=2018-08-08_11h43_14.png
http://knowledge.homecaresoftware.co.uk/lib/exe/detail.php?id=letters&media=wiki:2018-08-08_11h21_18.png
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5. The number of sources in your CareFree depends on how long this 

export will take. A progress bar will load indicating a visual of completion 

 

6. A prompt will appear letting you know where the merge export has been 

saved to 

 

 

7. Open a new Microsoft Office Word 

document 

8. Click into Mailings 

9. Click into Select Recipients 

10.  Click Use an Existing List… 

11.  This will open your file explorer, locate the document we exported from 

CareFree 

12.  When found, Word will give us the following prompt 

 

13.  Click OK 

Remember to note down this location as we will need it to create the mail merge document 

http://knowledge.homecaresoftware.co.uk/lib/exe/detail.php?id=letters&media=2018-08-08_11h51_12.png
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14.  In the Mailings tab, use the Insert Merge Field to enter in what source 

information you want on the document 

 

 

15.  Write up your letter using the merge fields to fill in the source 

information 

 

 

16.  If this document would need to used multiple times, i.e. monthly, the 

document can be saved but ensure the document is saved as a Word 

Template. Save the word document as usual but in the Save as 

Type drop-down change this to Word Template 

 

 

  

http://knowledge.homecaresoftware.co.uk/lib/exe/detail.php?id=letters&media=2018-08-08_11h57_59.png
http://knowledge.homecaresoftware.co.uk/lib/exe/detail.php?id=letters&media=2018-08-08_12h21_47.png
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17.  To run the mail merge ensure you have the correct merge document 

open, go to Mailings 

18.  Click Finish & Merge 

19.  Choose the most appropriate option, we recommend to Edit Individual 

Document to allow you to check over the merge 

 

 

20.  Ensure All is selected then click OK 

 

 

21.  The mail merge will then fill in all the merge fields with the exported 

information we retrieved from CareFree 

 

 

Each page of the merge will be an individual source allowing each page to be sent individually 

http://knowledge.homecaresoftware.co.uk/lib/exe/detail.php?id=letters&media=2018-08-08_12h30_09.png
http://knowledge.homecaresoftware.co.uk/lib/exe/detail.php?id=letters&media=wiki:2018-08-08_12h36_06.png
http://knowledge.homecaresoftware.co.uk/lib/exe/detail.php?id=letters&media=2018-08-08_12h26_40.png

